Population Estimation Tutorial

Prepared by Thomas Cucinotta, Jay Devenger, Lane Thornton, and David
Vecchiarelli
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Introduction
The purpose of this document is to demonstrate a methodology for estimating the population

living in a floodplain. This tutorial provides instruction for the process of collecting the necessary data,
adjusting the Census blocks that are not completely contained within a floodplain, creating a population
map, and the steps to produce the finished map. Following the steps in this document, the user will

learn to:

e Upload files to ArcGIS.

e Use the Clip tool to edit layers.

e Change the properties of layers.

e Set up ArcGIS in a way that allows the user to effectively count houses within Census blocks.
e Create population maps using the symbology menu of ArcGIS.

e Export data from ArcGlIS layers.

e Use the Select Features and Statistics tools to find populations of areas.

e Use Layout View to add a title, legend, scale bar, and north arrow to a map.

e Exporta map.

Upon completion of this tutorial the user should have acquired an understanding of ArcGIS and
Census data. The products that will result from this tutorial are a population map, and an estimate of

the population within the floodplain(s).



Getting Started

Before you get started, you will need a computer equipped with the proper software and data
files.

Necessary Software:
e ArcGIS 9.2 or higher
e Open Office 3.2 or higher
e Microsoft Excel 2007 or higher

Necessary Files:

e Aerial photographs of the floodplain and surrounding area. These aerial photographs are
obtained from a map database maintained by the Jacksonville District of the USACE.

e FIRM Map files of the floodplains under study. These are obtained from the Federal Emergency
Management Agency (FEMA).

e Census Blocks containing U.S. Census population data. This data is obtained from a map
database maintained by La Junta de Planificacion. It can also be found in the U.S. Census Tiger

Files Database at http://www.census.gov/geo/www/tiger/.




Step 1: Uploading Files into ArcGIS 9.2

The first step towards a population estimate is uploading the correct files into ArcGIS 9.2. First, open

ArcGlS and select the A new empty map option and click OK.

’@Archﬂap [i_g-y

Start uzing Archdap with

A template

Templates provide ready-to-uze lapouts and base maps
for wariouz geographic regions.

B ®®

(" An existing map:
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Figure 1: Opening Screen



Adding FIRM Maps

Click the Add Data button on the toolbar. Find the folder where the FIRM map data is saved. These files
will be called firmmaps_areas. Select these files and click Add.
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Figure 2: Adding FIRM Map Data

Right-click on firmmaps_areas . Click on Properties, then click on the Symbology tab. Click Categories.
Under Value Field, click Flood_Zone, then Add All Values. Click Apply, then OK. In this example, FIRM
map data has been uploaded for the entire municipality of San Juan. The resulting screen should look
like Figure 3.

Figure 3: Uploaded FIRM Map Data



Adding Aerial Photos:

Click the Add Data button on the toolbar. Find the folder where the aerial photograph files are saved,

select them, and click Add.

[ Add Data ot

Look in: II:I Aerial Photographs j El E’lﬁl%l Be %lggl
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Figure 4: Adding Aerial Photos



The resulting screen should look like Figure 5. In this example, twenty-one files were uploaded to cover
the entire Municipality of San Juan.

Figure 5: Uploaded Aerial Photos

The next step is to consolidate all aerial photos into one layer. Right-click on Layers and select New
Group Layer. Rename this layer Aerial Photos. Drag and drop each aerial photo layer into Aerial Photos.

Then drag and drop the Aerial Photos layer under the FIRM maps, so that the FIRM maps appear on top
of the aerial photos.



Adding Census Blocks
Click the Add Data button on the toolbar. Find the folder where the Census Block files are saved, select
them, and click Add.
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Figure 6: Adding Census Blocks

The resulting screen should look like Figure 7.
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Figure 7: Uploaded Census Blocks
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In this example, all of the Census blocks for Puerto Rico were added. It is not necessary to have any
Census blocks outside of the areas of interest, so the next step is to clip the Census block layer within
the area covered by the aerial photo. In the Arc Toolbox, expand Analysis Tools, expand Extract, and
double-click Clip. The Clip Tool will open. For the Input Features, select the Census Blocks layer, called
PRBlocks in this tutorial, from the drop-down menu. Select the FIRM map layer from the drop-down
menu and click OK.

r}%cnp s

& InputFeatures

| Ry
& Clip Features

| Zl Er"j
& OutputFeature Class

|

XY Tolerance (optional)

Meters |

QK Cancel Environments... Show Help >>

Figure 8: Clipping the Census Blocks
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When the clip tool has finished, click Close on the clip window. This will create a new layer that will
include all Census blocks within the desired area. In this example, the clipped layer includes all Census
blocks within the Municipality of San Juan. To remove the original Census block layer, right-click on it
and click on Remove. This should result in a screen like Figure 9.

Figure 9: Clipped Census Blocks
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All of the necessary files are now uploaded. Each layer can be turned off and on individually by checking
and un-checking the boxes next to each layer. Next, double-click on the colored box under the name of
the Census block layer. Select Hollow and select 2.00 for the Outline Width. Choose a distinct color for
Outline Color and click OK. In this example, red is used as the Outline Color.

Symbol Selector B |
Cateqgory: I Al ;] — Preview
Green Blue Sun =
—Options
Fill Colar:
Hollow Lake Rose : :
Outline Width: &
lZ.ﬂ'I} _!?
Cutline Color: . | 'l
Beige Yellow Olive
Properties... I
Green Jade Elue More Symbols i ’
Save... | ]
\ - I Cancel I

Figure 10: Changing Census Block Color
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The resulting screen should look like Figure 11. This is the end of Step 1: Uploading Files into ArcGIS 9.2.
All of the necessary files are uploaded and prepared for Step 2: Selecting a Floodplain.

% Untitled - ArcMap - ArcView

| File Edit View Insert Selection Tools Window Help

| Bditor = | B | # = Tak [Create ey Feature =1 | rerget: | =[x 1 |
| DEE&E ¢ B@BY o b e RNFEAECE =110 (@RELOPED P R OMH L LT
5 £ Layers & ArcToolbox
= E PRBlocks Clips 18 Analysis Tools
(] -y Extract
5 B firmmaps_areas LA Clip
[ <all other values> L select
FLD_ZONE L Table Select
[Z10.2PCT ANNUAL | & Overlay
AR & Proximity
A0 iy Statistics
Ve & Cartography Tesls
mx & Conversion Toals
# B Acrial Photos -8 Dats Management Tools

- Geocoding Tools

51 & Linear Referencing Tools
@ Multidimension Tools
= Samples

18 Server Tools

43 Spatial Statistics Tools

1| 1. | » -
Display [ Source | Selection Favories [Index | Seach [ T4 || o | 2 u 4] o
| Drawing ~ & i 9] Al Y0 sl BrulAr B Fr 2~

Figure 11: FIRM Map with Census Block Outline
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Step 2: Selecting a Floodplain

The FIRM map layer is broken up into 5 distinct floodplain designations. They are 0.2 Percent

Annual Chance, AE, AO, VE, and X. Each designation represents areas with different flood insurance

rates. The X designation represents areas that where flood insurance is not required. The steps for

calculating the population of each other designation are identical, so only one such procedure is detailed

in this document. This example uses the AE designation.

In order to highlight the floodplain designation under immediate study, right-click on the FIRM

Map layer, and select Properties. In the Layer Properties menu, select each floodplain designation not

under study and click Remove. Figure 12 shows the Layer Properties menu after the removal of all but

AE floodplains.

e ]

Cancel | Apply

|

Figure 12: Final Layers Property Menu

PO ————— B
General I Source I Selection I Display Symbology ! Fields I Definition Queryl Labels I Joins & Relates l
Show: i
ki !Dm'lr categories using unigue values of one field. Impaort ... I
Categories -Value Field rColor Ramp
L. = |
Unquevaes | [FLD_z0NE =1 | [ - —— ]
|Unigue values, marny L
Mat_u:_htn gymbols in a Symbal I Value I Label i Court I
Quantities
Charts <all other values: <all other values:
5 : Heading> FLD_FOME
Multiple Attributes = =
: I AE 2
Add All Values Add Values... | Remove I Remowve Al | Advanced v|

Click Apply and then OK. Double-click the colored square next to All Other Values under the FIRM map

layer. Select Hollow and click OK. Double-click the colored square next to the flood zone designation

under the FIRM map layer. Select a color for the flood region. In this example, 10% Simple Hatch is
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used in order to allow the aerial photo to be seen beneath the hatch marks. Select 2 for the Outline

Width and distinct color for both Fill Color and Outline Color and click OK.

% Untitled - ArcMap -

| File Edit View Insert Selection Tools Window Help

| Edtor = | | #% Task: [Create New Feature =1 | Targe: |
D& ¢« L @X | n o | [l i &e O ‘?‘ IECE R EE NN
= £ Layers 68 ArcToolbox
= & PRBlocks_Clips & Analysis Tools
O - Cartography Tools
2 B firmmaps_areas 1 @ Conversion Tools
[<all othervalues> | | & Dats Management Tools
FLD.ZONE 1@ Geocoding Toals
(=4t} & Linear Referencing Tools

Aerial Photos & Multidimension Taoks
1. Samples

1 @ Server Tools

& Spatial Statistics Tools

i Options ——————————————

ull B R

Hollow Lake Rose
Outline Width =
200 =)

000 =

Beige Yelow Olve

D I:‘ e
WMere Symbols =

e —

Display | Source | Selection Favories |Index | Ssarch | F4 | v|lg o | 2 u 4]

Igmwmgv k | o= |[@1 A == nIuiA-&v.iv-v

Figure 13: Selecting Floodplain Color
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Figure 14 shows a magnified view of a community in San Juan within an AE floodplain. The blue hatch
represents the area within the floodplain and the red lines represent the Census block boundaries. The
buildings in the aerial photograph can be easily seen through the hatch. The map is now ready for Step

3: Counting and Population .

. tutorial.mxd - ArcMap - ArcView

| File Edit View [nsert Selection Tools Window Help ‘

| Edtor v | b | # = Touk [Create NewFeature =1 | Torace | B el == e ‘

[DEES s B@x EXEs
G S
B 2v=r] [ ArcToolbox ¢
= B PRBlocks_Clips @ Analysis Tools < ’ %
O & Cartography Tools oy 'I
= B firmmaps_areas & Conversion Tools / //
<gll other values> || | @ Data Management Tools : ﬁ ,{1
FLD_ZONE & Geocoding Tools Proy SRR 5
[ ]2 G Linear Referencing Tools |y 7
Acrial Photos & Multidimension Tools
18 Samples

G Server Tools
@ Spatial Statistics Tools

< mn »
Display [ Source | Selection

Figure 14: A Community in an AE Flood Region with Census Block Boundaries
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Step 3: Counting and Population Estimation
To determine how many people reside in the floodplain, it is necessary to estimate the

population in each of the Census blocks that are also in the floodplain. By following the instructions in
this section, a list of all of the Census blocks with the necessary information about each of these blocks
needed to estimate the population will be created. Each step below explains how to obtain the
following information: the ID number for each of the blocks, the population within each of the blocks,
the number of households within each of the blocks, the number of buildings in that block which are in

the floodplain, and the number of buildings in the block that are not in the floodplain.

18



Setting up the Spreadsheet
To create a layer of Census blocks within a specific floodplain, decide the specific zone to set as

the outline of the floodplain. Click the Selection tab, and then select Select by Attributes... which then

displays the window shown in Figure 15.

Layer: I@ firmmaps_areas
I~ Only show selectable layers in this list

Method: ICreate a new selection

"FID"
"FLD_AR_ID"
"FLOODWAY"
"SFHA_TF"
"STATIC_EFE"

=| <>| L'rkel

>| >=| Pndl

<|<=| Drl

=] o | met ||« i

|

SELECT * FROM firnmaps_areas WHERE:

| = Get Unique Values |GoTo: |

b

"FLD_FONE" ="AE

Figure 15: Select Attributes Window
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Select firmmaps_areas as the Layer. In the field under Methods, double Click on “FLD_ZONE”,

then click = and then Get Unique Values. Choose the desired zone (in this example it is the AE Zone).

The equation in the window should read “FLD_ZONE”=’AE’. Click OK. This selects the chosen floodplain

region. Next right click on firmmaps_areas, click Selection and Click Create Layer From Selected

Features, as shown in Figure 16.

J File Edit View Insert Selection Tools Window Help

x| o

= £F Layers
[0 PRBlocksAE
[0 "Firm Map Floodplain”
= :
pu, - Copy
EJAE ¥ Remove

Aerial = Open Attribute Table

Joins and Relates

@ Zoom To Layer

‘ﬁ Zoom To Make Visible

Visible Scale Range

J Editor = | 3 | c' = ICrEatE Mew Feature LI ‘ 'I'arget:l LI ‘_X' (=) | ‘E
IDEH&| % BB X | o || FZ | @ealwe @z
| spatalAdustment > | K P & | BHEE B[ F|P | B@E|EE D |6 BFE <]

]

@5 ArcToolbox Use Symbol Levels g g :
Ea Analysis T = - ] =
5 8 Baroct I & Zoom To Selected Features
I }" Cli Label Features M Pan To Selected Features
- Sel
& spl Convert Labelsto Annotation... [ Clear Selected Features
}% Tal f-'? Convert Features to Graphics... % Switch Selection
E]"% Sy Convert Symbology to Representation... B Select Al
Ex-B Proviy e Make This The Only Selectable La
E]—-% Statiti Data » Make This The Only Sele e Layer
[]--& Ca rthralp Save As Layer File... Copy Becords For Selected Features
- & Conversio Jin e s = ; =
- &8l Data Man; Properties... . : ol
< | I — T Create Layer From Selected Features _I
il IIndex I Searchl F{eg,ungl 20 i eF Open Table Showing Selected Features ; I_’I
|Qrawing' k(a@“:"ﬂj!z“@ﬂnal LIIWLIBIH|£'@I'£1'
Create a new layer containing the selected features |_ |247601.123 270219.259 Meters A

Figure 16: Creating a layer of a specific FIRM map floodplain region

This creates a new layer of a specific FIRM Map Floodplain. Next, it is necessary to create a

layer of the Census blocks outlined by each of the floodplains using the Clip tool described in Step 1:
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Uploading Files into ArcGIS 9.2. Select Analysis Tools, then Extract, then Clip, and the Clip tool is shown
in Figure 8.

Choose Census Blocks as the input feature, and the firmmaps_areas selection as the clip feature.
Type PRBlocksAE in the highlighted part of Output Feature Class field displayed in Figure 17. This
determines the name that the new layer will be saved as. Click OK to create a layer that allows visual

inspection of the floodplains and the population inside of them.

, —
A Clip - C=EREH ]
Input Features
[ PRBIoCKs_Clip2 - &
Clip Features
Ifirmmaps_areas ;j =

Output Feature Class
I C:'Program Files\WPI-POPpr-bloques'\PREIocks_Clip2_Clip.shp

'§

| ¥ Tolerance {optional)
I Meters

Lo

oK Cancel Environments... Show Help ==

Figure 17: Changing the Output Feature file name
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ArcGIS also automatically generates an attribute table associated with the layer which provides

the Census blocks within the flood region, and Census data about each block. To open this attribute

table, right-click on the PRBlocksAE layer and select Open Attribute Table, as displayed in Figure 18.

:E.

x|

= £F Layers

@ArcTDulbnx
O "Firm Map Floodplain”
O PRBlocks_Clip5_Clipl E% Extract
O firmmaps_areas

O firmmaps_areas2
O PRBlocks_Clip5_Clip

A Copy
> Eemowve

B Cverlav

-8 Analysis Tools

. }" Table Select

Open Attribute Table

Joins and Relates

4

<& Zoom To Layer

ﬁ Zoom To Make Visible
Visible Scale Range

Use Symbol Levels

Selection

Label Features

Convert Labels ta Annotation...

‘f"' Convert Features to Graphics...

Convert Symbology to Representation...

Data

Save As Layer File...

Properties...

it Tools

g Tools
ools

Tools

Figure 18: How to Open the Attribute Table
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A table like the one in Figure 19 will appear.

Attributes of “Firm Map Floodplain® L= | et S
FID | Shape* ID | FIPSSTCO | TRACT2000 | BLOCK2000 STFID STATE | COUNTY | TRACT | BLOCK | POP2000 | WHITE | BLACK| AMERI_ES | ASIAN | HAWHN_PI | OTHER | MULT_RACE| HISPANIC =~
3 0 ] Polygon 288 | 72139 080222 1010 721390802221010 |72 139 080222 | 1010 0 0 0 0 0 0 0 0 0 I:\
1 | Polygon 96 | 72127 000600 2000 721270008002000 |72 127 000600 | 2000 3 3 0 0 0 0 0 0 0
2 | Polygon 97 | 72127 000600 2001 721270006002001 | 72 127 000600 | 2001 0 0 0 0 0 0 0 0 o
3 | Polygon 98 | 72127 000600 2002 721270006002002 | 72 127 000600 | 2002 0 0 0 0 0 0 0 0 o
4 | Polygon 99 | 72127 000600 2003 721270006002003 | 72 127 000600 | 2003 0 0 0 0 0 0 0 0 o
5 | Polygon 100 | 72127 000600 2004 721270006002004 | 72 127 000600 | 2004 137 95 14 4 1 0 21 2 130
& | Polygon 105 | 72127 000600 2008 721270006002008 | 72 127 000600 | 2009 0 0 o 0 0 ] 0 0 o
7 | Polygon 106 | 72127 000600 2010 721270006002010 |72 127 000600 | 2010 271 241 " 5 0 ] T 7 256
L 8 | Polygon 107 | 72127 000600 2011 T21270006002011 |72 127 000600 |2011 0 0 0 0 0 0 0 0 0
9 | Polygon 110 | 72127 000600 2014 T21270006002014 |72 127 000600 |2014 0 0 0 0 0 0 0 0 ]
10 | Polygon 111 | 72127 000600 2015 T21270006002015 |72 127 000600 |2015 0 0 0 0 0 0 0 0 0
11 [ Polygon 112 | 72127 000600 2016 T21270006002016 |72 127 000600 |2016 3 23 1 0 1 0 5 1 18
12 | Polygon 115 | 72127 000600 3002 T21270006003002 |72 127 000600 |3002 ] 0 0 0 0 0 0 0 0
13 [ Polygon 137 | 72127 000700 2000 T21270007002000 |72 127 000700 |2000 2 0 2 0 0 0 0 0 <
14 | Polygon 139 | 72127 000700 2002 721270007002002 |72 127 000700 |2002 0 0 0 0 0 0 0 0 0
15 | Polygon 140 | 72127 000700 2003 T21270007002003 |72 127 000700 |2003 0 0 0 0 0 0 0 0 0
186 | Polygon 141 | 72127 000700 2004 T721270007002004 |72 127 000700 |2004 0 0 0 0 0 0 0 0 0
17 | Polygon 154 | 72127 000700 2017 T721270007002017 |72 127 000700 |2047 5 5 0 0 0 0 0 0 5
18 | Polygon 157 | 72127 000700 2020 721270007002020 |72 127 000700 |2020 0 0 0 0 0 0 0 0 0
19 | Polygon 160 | 72127 000700 2023 721270007002023 |72 127 000700 |2023 22 21 0 0 0 0 1 0 21
20 | Polygon 161 | 72127 000700 2024 721270007002024 |72 127 000700 |2024 32 32 0 0 0 0 0 0 3
21 | Polygon 162 | 72127 000700 2025 721270007002025 |72 127 000700 | 2025 0 0 0 0 0 0 0 0 0
22 | Polygon 1683 | 72127 000700 2026 721270007002026 |72 127 000700 |2026 2 2 0 0 0 0 0 0 2
23 | Polygon 184 | 72127 000700 2027 721270007002027 |72 127 000700 |2027 0 0 0 0 0 0 0 0 0
24 | Polygon 1685 | 72127 000700 2028 721270007002028 |72 127 000700 |2028 5 5 0 0 0 0 0 0 5
25 | Polygon 168 | 72127 000700 2029 721270007002029 |72 127 000700 |2029 0 0 0 0 0 0 0 0 0
26 | Polygon 1688 | 72127 000900 1000 721270009001000 |72 127 000900 |1000 32 32 0 0 0 0 0 0 18
27 | Polygon 169 | 72127 000900 1001 721270009001001 |72 127 000900 | 1001 30 25 0 0 4 0 0 1 26
28 | Polygon 170 | 72127 000300 1002 721270009001002 |72 127 000500 | 1002 434 416 13 0 14 0 pal 20 395
29 | Polygon 71 | 72127 000300 1003 T212700095001003 | 72 127 000500 | 1003 223 194 5 0 4 0 5 13 183
30 | Polygon 173 | 72127 000300 2000 721270009002000 |72 127 000500 | 2000 792 714 q 0 39 0 il 19 650
31 | Polygon 174 | 72127 000300 2001 721270009002001 |72 127 000500 | 2001 34 30 1 0 0 0 3 0 26
32 | Polygon 175 | 72127 000300 3000 721270005003000 |72 127 000500 | 3000 186 174 3 0 3 0 4 2 168
33 | Polygon 176 | 72127 000900 3001 721270009003001 |72 127 000900 | 3001 148 136 2 a 0 0 5 4 137 =
L [F— I || — —— '
Recore: 14] 4 T op[n|  show[Al Selected Records (0 aut of 1160 Selected) Options ~
L

Figure 19: Attribute Table

Using the data in the Attribute table create an Excel spreadsheet to estimate the population for

each Census block. To do this, copy the attribute table and paste it into Excel (individual columns in the

attribute table cannot be copied so it is necessary to copy the entire table into Excel where it can be

manipulated). Copy the attribute table by selecting all data (press Ctrl-A) Right-click on the left most

column and select Copy Selected. Then copy the following columns: ID (the Block ID) and POP2000 (the

population of each block) from the recently created Excel sheet and paste them into another Excel

spreadsheet. Then create columns for the number of buildings in the Census block and in the

floodplain, the buildings in the Census block but not in the floodplain, and the estimated population

living in both the Census block and the floodplain in the new Excel Spreadsheet. The columns of Table 1

show the columns of the spreadsheet with a description of the source of the information in that column.

ID

POP2000

Buildings Included

Buildings Excluded

Estimated Population

Given from
Attribute
table.

Given from
Attribute
table.

photos

Found by counting
buildings in aerial

Found by counting
buildings in aerial

photos

Equation 2

Table 1: Population Calculator Spreadsheet

23



Estimating Population
The next step is filling the empty columns in the spreadsheet with data. The column detailing

the average household size is calculated by dividing the population of the block by the number of
households. To fill in the columns with the number of buildings in the Census block included and
excluded from the floodplain, the team used the unclipped Census blocks and floodplain layers over the
aerial photos. Figure 20 is an example of a section of the resulting map. The floodplain is shaded with a

blue hatch so the aerial photo can still be seen, and the Census blocks are outlined in red.

Figure 20: Census Blocks near a Floodplain

If part of a building is in the floodplain then the entire building was considered to be within the
floodplain because FEMA requires all buildings that are partially in a floodplain to have flood insurance.
It was unnecessary to count the buildings in a Census block that is completely in or out of a floodplain.

For adjusting the population of the Census block, only the ratio given in Equation 1 is important:
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BUILDINGS INCLUDED
BUILDINGS INCLUDED+BUILDINGS EXCLUDED

(1)

If every building in the Census block is in the floodplain, Equation 1 is equal to one. Block 1 in
Figure 20 is an example of a Census block with all buildings in the floodplain. For this block, type a one
in the Buildings Included column and a zero in the Buildings Excluded column. If the floodplain areain a
Census block does not include any buildings, the ratio detailed in Equation 1 is equal to zero. Block 2 in
Figure 20 is an example of a Census block with no buildings in the floodplain. In this case, type a zero
into the Buildings Included column and a one in the Buildings Excluded column.

If the floodplain area in a Census block includes houses in the flood region and houses that are
outside the flood region, determine the estimated population by using the ratio in Equation 1. First,
count the buildings inside the floodplain, and the buildings outside the floodplain for each Census block.
Type the number of buildings inside the floodplain in the Buildings Included column and the number of
buildings outside the floodplain in the Buildings Excluded column. Block 3 in Figure 20 contains 17
buildings within the floodplain and 4 buildings outside the floodplain. In this case, 17 would be typed
into the Buildings Included column and 4 would be typed in the Buildings Excluded column. Equation 1 is
then equal to 17/21, approximately 0.810. This ratio is used to determine the Estimated Population
column. To determine the adjusted population of a Census block, Equation 2 was used, which multiplies

with the population of the Census block to get Equation 2:

2000POP*BUILDINGS INCLUDED
BUILDINGS INCLUDED+BUILDINGS EXCLUDED

)

Table 2 below gives an example where data that was collected was entered into the Population
Calculator Spreadsheet. It demonstrates how to determine the adjusted population in the three
different cases; when no buildings in the block are in the floodplain, when a portion of the buildings in

the block are in the floodplain, and when all of the buildings in the block are in the floodplain.

Buildings Buildings Adjusted
ID POP2000 Included Excluded Population
160 22 0 1 0
285 32 4 10 9
289 106 1 0 106

Table 2: Population Calculator Spreadsheet Example
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After the population for all of the Census blocks is adjusted within the floodplain region, sum all
adjusted Census block populations. Repeat this process for each flood risk designation, resulting in a

total population estimate for all floodplains.
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Step 4: Creating the Population Map
The next step is to add the newly estimated populations to ArcGIS. In ArcGIS, right click on the

PRBlocksAE and click on Data, then Export Data. Click OK, then a box will open up. If Yes is clicked it will
add the exported data to the map as a layer, this is not necessary as PRBlocksAE is already a map layer,
so Click No. This will create all the files associated with this layer, these files are the shapefile (.SHP), PRJ
, SBN, SBX, SHX, XML, and the database file (.dbf). When layers are exported they are named
Export_Output. By default the files are exported to the Desktop. Rename the files PRBlocksAE. Make
sure they are all named the same or they will not work properly. Open the database file (.dbf) with

OpenOffice.

Copy the Estimated Population column into the POP2000 column of the floodplain’s database
file and save it. The PRBlocksAE layer in ArcGIS now has the estimated population for the AE floodplain
region. The next step is to configure it in ArcGIS. Right-click on the PRBlocksAE layer and select

Properties click on the Symbology tab as shown in Figure 21.

Layer Properties

Genersl | Source | Selection | Display  Symbology | Fields | Definition Qu

Matural Breaks (Jenks)

Classes: |5 vl ﬂl

Value: | POP2000

¥ Graduated colors

‘. Graduated symbols Normalization: |none

Symbol | Range | Labe i

0-81 0-81

82-250 82-250

291-689 291-629
690 - 1297
1258 - 2348

Figure 21: Symbology Menu
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This menu is for determining the map’s color ramp, number of classes, ranges, labels, value to display,
and classification of classes. Change the Fields Value to POP2000. This configures ArcGIS to associate
each block on the map with its POP2000 value. The classification method chosen in this tutorial is

Natural Breaks (Jenkins). Select the desired method and Click OK.
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Using ArcGIS to Find Population Sums
To calculate the population of any arbitrary floodplain or section of floodplain, ArcGIS can

calculate the sum of the individual populations in a selected area. Before it is possible to select a
specific floodplain region, it is necessary to turn off all the layers that do not wished to be included in
the calculation. Then Click the Select Features utility in the Tools tool bar and highlight an area of

blocks.

tutorial —Axh@ -
J File Edit View Insert Selection Tools Window Help

_I Editor « | 3 |, Y. Task:ICreatENe‘\.\.- Feature ;l | Tar_qet:l L‘ |.>( = | ‘ |

| DEHES| ¢ BRX | w | & |[ee5o RINIARCR Rl o] ::::Wo«#ﬂmktﬁ
_ISpatiaIAdjustment' |k J?QHEEI t‘ﬂ,?e EA Eﬁzi?/d—l @@@|@ @ E:E E|l;|_3£3 - ||E| E.||£|r§| Select Features|
x Il

EF=] (overs|
= PRBlocksAE
POP2000
[Jo-81
[182-290
[ 291 - 689
I 690 - 1297
1298 - 2948
[0 "Firm Map Floodplain”
O firmmaps_areas
Aerial Photos

Display | Source | Selection | @02 n 4 ; ; |
'JQrawing' k(ﬂ@l[" A'E“@Mal ;”‘H] ;I B 7 Hii' &'i';' |
| |Select features by clicking or dragging a box !_|24ﬂ13.349' 270885.206 Meters ]

Figure 22 Select Features tool and a Selected Area

Next pull down the Selection menu and click Statistics. This opens the menu shown in Figure
23. The Selection Statistics tool displays statistics such as the count, minimum, maximum, mean, sum,
and standard deviation of the selected blocks. The count refers to the number of Census blocks that are
selected. The minimum is the lowest value that any of the selected blocks contain. The maximum refers

to the highest value that any of the blocks contain. The sum is the sum of all the values of each
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individual block. The mean is the calculated average of the population of all the selected blocks. Lastly,
the standard deviation displays the standard deviation of the values. The Selection Statistics utility can
calculate statistics of any layer that has been selected by the select features tool. The values that these
statistics are using to determine each statistic are decided in the Field Pull Down menu. To find the
estimated population of the selected area, select POP2000 in the Field Pull Down menu. The sum is the
estimated population of the selected area. The estimated population of the selected area in Figure 22 is

determined to be 15369 for the AE flood region, as shown in Figure 23.

AN

i

i
i
Ul

Lo

Blivmirrs v -
PN,

Figure 23 Selection Statistics Menu

30



Step 5: Layout View
Once the map has been configured it is ready to be formatted using the Layout view. To use
Layout view, click on View and select Layout View. This view is used to format the map for printing. This

section will explain each step to add a legend, title, scale, and north arrow.

Inserting the Legend

Legends explain the symbology used in a map. To insert a legend, pull down the Insert menu
and click on Legend. This will bring up the Legend Wizard, shown in Figure 24. This wizard provides a
step by step guide through the creation of the legend. The wizard automatically adds every item from
the layers to the legend. To remove the unwanted items, select the item and click <. Repeat this step

to remove all unwanted items. When all unwanted items are removed, click Next.

Set the number of columns in your legend: |1

Preview |

fial Pho 3 agubuesec?
- agubueswc agubuesec]
- agubuesw agubuese n
T agunueseU carol-swc’Z [
- agubuese - < carolswc it

[

=

Figure 24 First Window of Legend Wizard
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It is possible to change the font, size, and color of the title in this window. Type the desired

name of the legend, and click Next.

1
0.

Figure 25 Second Window of Legend Wizard
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This window configures the legend frame. Click Next.

il
1]

Figure 26 Third Window of Legend Wizard
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In this window, the size and shape of the symbol patch used to represent line and polygon features in

the legend can be changed. When done, click Next.

Preview |

< Back Next > | Cancel |

Figure 27 Fourth Window of Legend Wizard



This window sets the spacing between the numbers, symbols, and letters of the legend. Click Finish
after choosing appropriate spacing. To configure the style of the legend, double click on the legend

object box. This will bring up the Legend Properties window. Click on the /tems tab.

i

Figure 28 Fifth Window of Legend Wizard
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Double click on the legend item in the right column, in this case AE.

il

o,
.

KN

iy dispiay layers that are checked on in the Tabie Of Contents

<
o

v Add a new item to the legend when a new laver is added to the map

[ ok | cCamca | zoris

Figure 29 Legend Properties Window



From here it is possible to select many different styles for the legend. This tutorial uses the

horizontal bar with heading, labels, and description. Pick the desired style and click OK.

=
11

Figure 30: Legend Item Selector
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At this point the map should look similar to Figure 31.

Figure 31: Population Map with Legend
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Inserting the Title
Titles are used to describe the region and contents of a map. To add a title pull down the /nsert

menu and click on the Title option, as shown in Figure 32.

=# Data Frame

e ETR

a

A Ted

) Meatline...

3 Legend...
& MNorth Arrow...
== 5cale Bar...

i Scale Text..

Picture...
Object...

Figure 32: Insert Title
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A text box will appear with the project name in it. Double click on the text box to open up the

text properties menu.

Figure 33 Text Properties Menu

In this menu, text, font, color, and other attributes can be adjusted. After choosing an

appropriate title and its attributes, click OK.
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Inserting the Scale Bar

Scale bars are used to relate the distance on the map to the actual distance on the ground. To

insert a scale bar pull down the Insert menu and click on Scale Bar.

fii)
|
I

o = e
a - 1 o o 11 &0 |
Altemating Scale Bar 1 I
Altemating Scale Bar 2 :
00 Save... Reset
[ lusitz = .

Figure 34: Scale Bar Selector Menu

There are many different styles of scales available in the Scale Bar Selector window, shown in Figure 34.

Select a scale and click OK.
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Inserting the North Arrow
A north arrow identifies the north direction. Although it seems very simple it is crucial to be

aware of the orientation of the map. To insert a north arrow, go to pull down Insert and click North
Arrow. The North Arrow Selector menu is displayed in Figure 35. This menu provides a list of different

styled north arrows to choose from. Select a north arrow and click OK.

VIS~ ]
T <
! i

=

ESRI North 8 ESRI North 9

Figure 35: North Arrow Selector Menu
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Step 6: Finished Population Map

The last step is to export the map image. Pull down the File menu and Select Export Map.
Choose a file name and a file type. Click Save. The exported map is shown in Figure 36.

Legend

POP2000 i
B e — - — “—qu
[ - s Msters
& & & ®
o am_"fi:‘\_a '\’59 ..EP‘ H
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=
=

Figure 36: Completed and Exported Map

Figure 36 displays the finalized Population Map of all of the floodplains in San Juan, Puerto Rico.
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Conclusion
This tutorial has covered the essentials of creating a population map using ArcGIS. By the end of

Step 6 of this tutorial, the user should have attained an estimation of the population residing in the

floodplain and a population map illustrating the distribution of population throughout the floodplain.
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